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Introduction

Welcome to Personal Taxprep 2025!

This Quick Start Guide is designed to acquaint you with the Personal Taxprep program as well
as to give you tips on how to use the program. This is not an in-depth guide; please refer to
the Help any time for tax or technical assistance when you are in the program. For
information on tax changes, please refer to the Release Notes for each version.
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Overview

Different Views

The Personal Taxprep program is comprised of several different views that allow you to
perform different functions within the program.

The Personal Taxprep Views

"l

The Professional Centre provides important information about the program, tax
news and links for customer service and support.

The Client Manager displays all of your tax returns. You can use it to open and
roll forward files, print returns, EFILE, create reports and perform other
functions that help you to manage the tax preparation process.

The Client Manager (Planner Mode) provides easy access to any planner files
that you have created.

The Tax Return view is where you prepare the return. You can print or transmit
any open tax return from here.

The Print Formats view is where you define the print settings for each form
included in the tax return, such as the number of copies and the printer
selection.

The Preparer Profiles view allows you to create and manage one or more
preparer profiles.

The Filters and Diagnostics view contains predefined and customized filters and
diagnostics that you apply in the Client Manager or in the diagnostics pane to
generate reports or identify certain situations.

The Letters and Labels view is where you create customized templates for
letters, invoices and labels.

The Rate Tables view specifies the rates and values used in the tax return for
the current year and allows you to modify the rates used in Planner mode.

The EFILE Log lists all the transactions related to electronically filed returns and
provides follow-up options and reports.

The EFILE Archive stores archived transactions from the EFILE Log.
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Accessing Views

The various views in the program are accessed using the Menu button.

m Tax Retum - Personal Taxprep 2025 - D

B e e ook Tomion g i

- TaxRetum [EJ Open Forms - + | [sea - Q| Y alforms+ = pE - % ccH iFirm (A virtual Agent

You can also access the views using the
applicable shortcut key combinations.

A Professional Centre Ctrl+Shift+P

& Ciient Manager Ctrl+Shift+C

h Client Manager (Planner Mode) Ctrl+Shift+E

B Print Formats Ctrl+Shift+M
. Preparer Profiles Ctrl+Shift+R

Filters and Diagnostics Ctrl+Shift+F
u Letters and Labels Ctrl+Shift+L

/o Rate Tables Ctrl+Shift+B

A EriLELog Ctrl+Shift+0
W e Archive Ctrl+Shift+ A
D Help

-ﬁt Options and Settings

The name of the current view appears beside the Menu button.

m Tax Retumn - Personal Taxprep 2025 = =
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Toolbar
The toolbar provides quick access to the most common commands in the program.
TaxReturn [ Form Manage H e 0 - 95 Sy \ - Occririm- (f] vitual agent

The icons displayed on the toolbar will vary. For example, different icons will be displayed
when you are viewing the Form Manager vs. when you are viewing a form.

The toolbar icons will also vary from view to view, as some commands may not be applicable
in all views.

The Professional Centre

The Professional Centre is a dedicated Web page that provides the latest information on
Personal Taxprep, including automatically alerting you to any program updates.

On the Professional Centre you will see a link to the Help Centre and to support documents
such as the Release Notes as well as links to training resources and to the searchable
Knowledge Base. The Professional Centre also provides a link to submit a support ticket to
the Customer Service and Support teams.

For more information on the Taxprep Help Centre and the Knowledge Base see page 34.

Default View

By default, when you launch Personal Taxprep, the Tax Return view will be displayed.
However, in Tools/Options and Settings (see below), you can configure the program to
automatically open in the Client Manager or EFILE Log.

Setup

Options and Settings

You can configure most aspects of the program using the Options and Settings command on
the Tools menu.

Note: If you are using the Network version, several options and settings may be
pre-configured for various user groups. Check with your Network Administrator for more
information.

Click the section title to see a description of the options and settings contained in each
section. Any changes that you make will be saved automatically when you click OK or Apply.

Note: The options and settings are saved on your workstation and are unique to you.

Preparer Profile D 11p
Your preparer profile is configured in the Preparer Profiles view. You can have multiple When creating
preparer profiles (e.g., you can have a separate preparer profile for returns that are not additional preparer
prepared for remuneration). profiles, you can

. make a copy of any
Click New to create a preparer profile. If you do not create a preparer profile, the program existing profile and
will use the defaults for the various options presented in the Preparer Profile view and the simply change
name of your firm will remain blank on the last page of the T1 jacket. selected fields.

The Preparer Profile edit screen has eight tabs: Profile, Staff, Authorization Forms, EFILE,
Client Letter, Bill, Interest and TaxprepConnect.

Click the Profile tab to enter information about your firm and your preferences with respect
to preparing and filing your returns.
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Click the Staff tab to enter the names of the staff and partners using Personal Taxprep for
purposes of selecting these names in each return for tracking purposes.

Click the Authorization tab to enter information and modify settings used when completing
and filing the Québec MR-69 authorization request form in Personal Taxprep.

Click the EFILE tab to modify the settings used for electronic filing of T1 and TP1 returns, T1135
information returns, pre-authorized debit agreements, as well as default information for
Discounters.

Click the Client Letter tab to configure the options for the client letter, including entering any
standard opening or closing paragraphs.

Click the Bill tab to configure your billing options in the Invoice Profile, including the
standard charges for the detailed invoice.

Click the Interest tab to configure the default settings for the Form Interest (Jump Code:
Interest) which can be used to calculate interest on unpaid balances and late-filing penalties.

Click the TaxprepConnect tab to configure the default settings for reconciling and
transferring data downloaded using TaxprepConnect.

The first time you save a specific preparer profile, the program will display the Preparer
Profile Properties dialog box.

You can enter a new name and description for your preparer profile. Click Default if you want
that preparer profile to be used by default. You can change the information in this dialog box
at any time using the Set Properties command. Click OK to return to the Preparer Profile
view.

All of the profiles that you create will appear in the list of Preparer Profiles. A check mark will
appear beside the default Preparer Profile.

Refer to the Help for more information on the Preparer Profile.

Preparing Returns

Roll Forward

If your firm used Personal Taxprep last year, the files for any returning clients can be rolled
forward from the prior year. You may also be able to roll forward data from files created
using another T1 program.

What is a Roll Forward?

The roll forward procedure creates a new file for the current taxation year based on what was
in last year’s return to avoid re-entering information that was gathered in a prior year.

When a file is rolled forward, the permanent information (e.g. name, address, date of birth) is
retained and the closing balances of carryforward amounts (e.g. undepreciated capital cost,
unutilized prior year losses and RRSP contribution room) become the opening balances.

In addition, if the file was prepared using Personal Taxprep last year, the data entered in the
prior year file is retained for comparison purposes.
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Using the Roll Forward

From the Tax Return view, you can roll forward one or more client files from a single folder as
follows:

e On the File menu, click Roll Forward.

e Select the folder where the client files to roll forward are located.
e Select the client file(s) from last year that you want to roll forward.
e Click Open.

e The Roll Forward dialog box will be displayed on the screen. In the File Options and Data
Options tabs, select the desired options.

e Click OK to start the roll forward process.

When a single file is rolled forward, it opens in the Identification form.

Rolling forward files from Multiple Folders

If your prior year files are in different folders, you can use the Client Manager to view a list of
all of last year’s files from multiple locations and select the files that you want to roll
forward.

Converting files from other programs

- You can convert and roll forward files from other
Taxprep Files (*.124) programs in the same manner as you roll forward
Files (*.124) Personal Taxprep files.

é-arnhaa:flzl:r:s '}Sﬁgc,_,-} If you are rolling forward these from the Tax Return
ProFile T1 Files (*.248) view, select the appropriate file type from the drop-
TaxCycle T1 Files (*.2024T1) down list in the bottom right corner of the Roll

Forward dialog box.

If you are converting files from other programs using the Client Manager, select the
appropriate file type from the list beside the “Files to Roll Forward” filter.

Opening Files

If your files have already been rolled forward, simply open the file you want and begin
working on it. To open a file, select Open on the File menu.

In Taxprep, you can have multiple files open at the same time.
You can open several client files at the same time using the Client Manager. Simply select the
client files you want to open, then on the File menu, click Open.

Opening Prior Year Files Using Shortcuts

When rolling forward the prior year client file, a shortcut to that client file will be
automatically created. The shortcut will allow you to quickly access the prior year file.

This shortcut will be available using the Prior Year/Open last year's client file command on @ TIP
the File menu or by pressing Ctrl+E. It is also accessible by clicking the Prior Year icon on the
toolbar and selecting a shortcut to a prior year file. Once you have

. . L . . finished work on a
When you click the shortcut for the 2024 client file, it will be opened in the 2024 version of specific data file,
Personal Taxprep, provided it is installed and accessible. Similarly, if there is a shortcut for a close the file to
pre-2024 client file, it will be opened in the appropriate version of Personal Taxprep, avoid entering data
provided it is installed and accessible. into the wrong

return.

You can also modify or delete existing shortcuts and create new shortcuts manually.

9
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Note that you can manually add shortcuts to other current year client files (e.g. shortcuts to
client files for related parties). Once created, the shortcut will allow you to quickly access
another client file.

Client Manager

The Client Manager provides information on all of your client files.
It is used when you want to perform a function on multiple returns, such as:
e opening returns;

e rolling forward data;

e recalculating returns;

e changing the return status;

e locking the data;

e applying passwords;

e importing data;

e generating reports on your clients;

e printing returns;

e printing letters and labels;

e electronic filing;

e syncing contact information with iFirm.

The Client Manager is also a useful tool for easily locating the files that you want to open.
You can sort your returns by any field and find a return by typing the taxpayer’s name.

For more information on the Client Manager, refer to the Help.

Note: Advanced tax return monitoring is available using CCH iFirm Tracking. For more
information, visit https://www.wolterskluwer.com/en-ca/solutions/cch-ifirm/cch-ifirm-

tracking.

Family Returns

The taxpayer, spouse and dependant returns can be in the same data file to facilitate the
exchange of information between the returns.

You can toggle between the taxpayer and spouse returns by:

A

o clicking Switch to Spouse on the View menu; or

e clicking the icon on the toolbar; or
e pressing Alt+F7.

The Client drop-down list in the top right corner of the tax return window displays all the
open client files as well as the names of the individuals whose returns are in each open client
file.

You can also use this list to select a specific return within any open client file.

By default, the taxpayer, spouse and dependant returns are displayed in different colours.

10
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Starting a New Return
Click New to start a new return.
Personal Taxprep will open in the Identification form.

If you are using CCH® iFirm®, you can sync certain identification data between the Personal
Taxprep client file and your client contacts in CCH iFirm. Refer to the Help for more
information. If preparing returns for both the taxpayer and spouse, select the marital status
on the Identification form. Then select the Taxpayer and spouse returns prepared together
check box.

Note: Coupled returns can easily be separated into separate client files, if needed, by
removing the X in the Taxpayer and spouse returns prepared together check box.

If the taxpayer is married or common-law and the return is not coupled, the spouse’s income
must be indicated on the Identification form (this is required for EFILE purposes as well as
the bar code that prints on the T1jacket).

Note: If no income for the spouse is entered, then the spousal amount will not be calculated @
unless you select the option “The spouse’s net income is nil or negative.” TIP
If you have
H separate returns
Accessing Forms that you now want
There are two different methods for accessing forms in Personal Taxprep: selecting forms to process together

(e.g. where the
couple is now

considered
Form Manager common-law), you

To view the Form Manager, press F4 or click the Form Manager icon on the toolbar. can combine them
into one family file

from the Form Manager or using Xpress.

The Form Manager provides easy access to the various forms available in Taxprep.

Simply select the form that you want, then press Enter or double-click to open the form.

To help you locate your forms quickly, Taxprep assigns a jump code for each form. Simply
start typing the jump code and Taxprep will search for that code.

Jump Code conventions:

e Jacket: line number / TP1for Québec TP1 jacket

e Schedules: Schedule number (e.g. 3 for Schedule 3)

e Slips: T-slips number (e.g. T4)

e Worksheets: Acronym or short form (e.g. RRSP for RRSP Worksheet)

Note: Jump codes used for the Québec return are preceded by the letter “Q” (e.g. QA for
Schedule A).

If you don’t know the jump code of a form, you can use the search field on the toolbar (or
press Ctrl+F). Simply enter your search text and the program will display all of the forms that
contain that search text as part of the jump code, title or description.

Open Forms

Once a form is open, a tab for the form will appear at the top of the form display. Click any
form tabs to view an open form. Click the Close (X) button or press Esc to close form and
remove the form tab.

You can also access forms by drilling down from a form using the Expand command (e.g.
beginning in the Jacket and expanding).

Press F6 to toggle back and forth between the current form and the last form viewed.

11
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Press F8 to toggle between federal and provincial equivalent forms.
Press F4 to toggle between the Form Manager and the open forms.

Note: The program will retain information about what forms were opened and where the

cursor was positioned, so that the next time the file is opened (by any user), the same forms

will be opened automatically.

Xpress

Taxprep Xpress allows you to view the data in the return in a table format. You can select a
filter to limit the data that you are viewing (e.g. only view the data entered in the current
year).

The data in the Xpress table is fully interactive with the data in the forms. Any change made
on the form will be immediately reflected in the Xpress table and vice versa.

Instead of jumping from form to form to enter data, with Xpress, you can simply scroll
through the list of data entered in prior years and type in this year's amounts.

On the View menu, click Xpress (or click the Xpress icon on the toolbar) to display Xpress.
You have two options for displaying Xpress: Dock and Float.

If you choose Dock, Xpress will be displayed in a pane at the bottom of the Taxprep window.

If you choose Float, Xpress will be displayed in a separate window which you can reposition
(e.g. onto a second monitor).

Xpress can also be a useful tool for reviewing the return. See page 22 for more information.

Expand (F9)
When you are on a form, you can move to another related form by “Expanding.”

Expanding allows you to move from one form to another without first going to the Forms
Manager. You can expand from any cell with an arrow symbol beside it I ojod to
display that cell’s source form.

Access a source form from an expandable cell as follows:

e onthe Forms menu, click Expand.

e right-click and then click Expand on the shortcut menu.
e pressF9,or

e double-click the cell.

12
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As most returns use
more or less the
same forms and
fields from one year
to another, using

Xpress is an
excellent way of
quickly accessing
the fields that you
are most likely to
need to complete
for the current year.
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Cell Display

Personal Taxprep uses flags to identify the properties of the cells. The colours indicate if the
cellis calculated, calculated but overrideable, or input. The following are descriptions of the
most common cell display:

Protected cell

Cell Type Appearance Definition
1,000
Input cell Black text on white Data entry cell.
background
1,000

Black text on same
colour background as
the form

No input or override is possible.

Expandable cell

1,000
. Calculated cell where content can
OVer”deable Ce”. Black text on grey be OVerridden.
background
’ 1,000

Blue arrow pointing into
the cell.

Cell in which the content comes
from another form.

Cells with review
marks

1,000
. - Calculated cell where content has
Overridden cell Black text on pink been overridden.
background
‘ _1’000 Cell that was rolled forward from
Rolled Forward Cell Blue text on white the prior year
background
Cells with data 0 Cell in which data was entered last
tered last but year but no value has been entered
entered fast year but | pjack text on yellow or rolled forward in the current
not this year background year
Cells with Cell in which data has been
[}|U[} downloaded from the CRA or RQ via
downloaded data TaxprepConnect
Cell in which data was first
Cells in which downloaded from the CRA or RQ
downloaded data has 1,000|00 using TaxprepConnect and whose
been overwritten (c:ic_)ntei(n_t waf then replaced by a
irect input.
1,000/ Cell that has been marked as part

Red indicator on the
right-side of the cell

of a review. Five types of review
marks are available.

Cell with diagnostic

1,000

Red triangle in the upper
right corner

Diagnostic applies.

13
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Cell Type Appearance Definition
_la
Cell with attachment — 1,000 Cell to which a note or schedule
Paper clip in the upper | has been attached.
left corner
1,000,

. . - - Cell with an InfoConnect Tax Hint
Cell with tax link Blue triangle in the and link to a Tax Research product.
lower right corner

Entering Data
Entering data on the forms is made easy.

If an amount is a round figure, there is no need to enter the cents (“.00”). The program will do
it for you.

“un

If an amount is a negative number, precede it with a

Data can be entered into overrideable cells, simply by entering the data. The program will
prompt you to confirm the override before displaying the amount.

Special Forms

Multiple copy forms

There are a number of tax forms for which you may require several copies. For example, on
the data entry screens for T-slips, you will require a separate copy for each T-slip received by
the taxpayer.

For these forms, Taxprep allows you to create multiple copies of the forms. A Multiple Copy
toolbar appears at the top of each multiple copy form to simplify navigation between copies.

1 5 6

= !

€& —> | [5-CBCINVESTORSERVICESINC | [ New [iil] Delete Q Search
2

4

1. Displays the first copy of the form.

2 The Previous button displays the previous copy, and the Next button displays the
next copy of the form.

3 Displays the last copy of the form.
4 The Copies list provides access to all the copies that have been created.

5 The New button creates a new copy of the form and the Delete button deletes the
copy displayed on the screen.

6 The Search button allows you to search for a specific copy of the form by entering
any part of the description.
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Attachments

You can create both attached notes and attached schedules. Once a note or schedule has
been attached to a cell, a paperclip will be displayed in the left corner of the cell.

Meals and entertainment
Incurred i I:||DIII ¥ 50%

Attached Notes
You can attach a note to any type of cell by right-clicking then selecting Attach Note or
pressing Alt+F10.

If you want the note that you create to be rolled forward to next year’s return (e.g. because
the note may also be applicable next year), select the following option:

[ Keep this note when rolling forward the file

When you hover your pointer over a cell that has an attached note, the note will appear.

Attached notes are summarized on the Form Attached Notes - Summary (Jump Code: ATTN)
which can be printed along with the return. The notes can be sorted according to the order
the forms appear in the Form Manager. The name of the user that last edited the note, as well
as the date the note was last modified, will be displayed on the Attached Notes - Summatry.

You can also navigate to a cell that has a note attached by double-clicking the name of the
cell associated to the note from the Attached Notes — Summatry.

Attached Schedules

The attached schedule (Jump Code: ATTS) is a multiple copy form. Each time you attach a
schedule to a cell, a new copy of the attached schedule is added to the form and linked to
this cell.

You can navigate to a cell that has the schedule attached by double-clicking the name of the
cell associated to the note from the Attached Schedules.

Attached Schedule with Total

Note: This form will not be transmitted electronically or taken into account for the printing of bar codes

Private health services plan premiums

Tite  Private health services plan preiumns deductible

Explanatory note (press Cir+Enter to insert a line break)

Per paragraph 20.01(2)(c), where insured arm's length employees comprise less than 50% of the total of insured persons carrying on the
business and insured employees (or if there are no employees), the amount of PHSP premiums deductible in respect of a peried in a
taxation year for coverage of the individual and his household members is first limited to $1,500 for each of the individual, his spouse or
common-law partner and any household member over the age of 18, and $750 for each household member under the age of 18, pro-rated
based on the number of days in the period which are in the year.

] Add W Delete
Description Amount
Maximum deduction: Per adult hd 1,500/00
X number of adults covered * > 3|00
+ - 0/00
Total 4,500/00
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To attach a schedule:

1. Select the cell to which you would like to attach a schedule.
2. On the Edit menu, select Attach Schedule.

You can also add copies that are not linked to any cell.

For more information on the Attached Notes and Schedules, refer to the Help.

Multi-Line Tables

Several forms contain multi-line tables. For example, Schedule 3, the Investments worksheet,
the Medical Expenses worksheet, the Charitable Donations worksheet, and the
RRSP Deduction worksheet all contain these tables.

A new line (or set of lines) is automatically added as soon as data is entered.

You can also use the Add button to create a new line or lines. Use the Delete button to
remove a line.

Family Profile
You will require a separate copy of the Family Profile for each dependant in the family.

If the dependant will not be filing a tax return, then simply enter the applicable information
on the Family Profile for that dependant and it will be used to calculate the various relevant
deductions and credits in the supporting individuals’ returns.

If the dependant is filing a tax return, then you can create a separate return for that
dependant within the family data file if one does not already exist.

Select the “Add a dependant’s return” field to create a new return for that dependant or to
merge in a separate data file containing the dependant’s return.

Self-Employment Forms

Self-employment statements are multiple copy forms, i.e. you can create as many copies as
you need to accommodate multiple businesses or farm or fishing operations.

However, self-employment statements are linked to related supplementary forms for that
business/farm/fishing operation which appear on the Form Manager to facilitate easy access:

These supplementary forms include:
e CCAschedule
e Auto schedule
@ TIP

e Five-year Comparative

Jump to ATTS on the

Every time you create a new copy of a self-employment statement, Personal Taxprep will Form Manager to
automatically create copies of additional forms that are related to that statement: access all of the
attached schedules.
Client Letters Use the Multiple
Copies toolbar to
Previewing a Letter find a specific

attachment.

Letter templates are linked to letters on the Form Manager. When you print or display a letter
from the Form Manager, the template content is merged with the data in the active tax
return. The resulting document is a letter that contains information specific to each client's
situation.
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By default, Personal Taxprep will use the letter Client letter - Electronically filed return (Jump
Code: CLE) for all EFILE-eligible returns. However, there are multiple letter templates
available and you can select an alternative default letter in the Client Letter tab of the
Preparer Profile.

Changing the Contents of the Letter
You can change the contents of the client letter for a specific client in two ways:

e Modify the data in the Client Letter Worksheet; or
e Edit the Letter Preview.

Modify the Client Letter Worksheet

The Client Letter Worksheet (Jump Code: LW) is used to select and modify the information that
appears in the client letters. It is also used to override which letters are applicable to the
return.

You can enter additional information for this return, such as the name of a specific
partner/staff member to appear at the bottom of the letter in addition to the firm name.

You can also enter optional opening and closing paragraphs specific to this return.

Any data that you enter in the Client Letter Worksheet is saved with the return.

Editing the Letter Preview

You can edit the letter preview to temporarily change the letter generated from your
template. You can add, delete or modify the text in the letter as well as pasting in text from
another source (e.g. a Word document). However, the edit will only stay in effect while you
are in the letter preview. The next time that you access the letter preview, your edits will be
lost, as the preview will be regenerated from your template to ensure that it reflects the
latest data in the return.

You can, however, save your edited version of the letter preview to an .rtf file which is
compatible with word-processing programs, using the command Save Letter As on the File
menu. If you have edited the preview, Personal Taxprep will ask you if you want to save the
edited preview when you leave the form. When the letter preview is saved, the program will
give you the option of automatically opening the .rtf file in your word processing program.

You can also print the edited letter preview using the Print Form command similar to any
other form.

Changing all Client Letters

If you want to make a change for all of your client letters (e.g. change the wording of a
specific paragraph, or add the firm logo to the letter), you can edit the appropriate letter
templates.

For information on editing the letter templates, refer to the Help.

Transferring Data between Returns

Coupling and the Family Data Connection

The program allows you to prepare and save the returns of all family members (i.e. the
returns of the parents and the dependants) in a single client file. This way, the family
situation is optimized and if a change occurs in the common information, you only need to
make the modification in one return.

When returns are coupled, the shared information is the data that is generally the same for
both the taxpayer and spouse returns. To reduce data entry time, this data only needs to be
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entered in one of the returns. The program will automatically transfer the information to the
other return.

Similarly, when a dependent return is included in the data file, any relevant data entered in
the dependant’s return will be transferred automatically.

Pension Income Splitting
Taxprep generates a diagnostic when it detects that the taxpayer and the spouse could
benefit from pension income splitting.

Taxprep can automatically determine the optimal percentage of eligible pension income to
split in order to minimize the tax payable for the couple. On the Form T1032, Joint Election to
Split Pension Income (Jump Code: 1032), click the Calculate button in the section “Step 3-
Elected split-pension amount.” The details of the effect of income splitting can be viewed on
the Form T1032, Comparative review of the split-pension effect (Jump Code: 1032 COMP).

For more information on pension income splitting, consult the Help by pressing F1in the
T1032 form.

Importing and Exporting

Personal Taxprep supports a number of different types of importing and exporting:
e Importing downloaded tax data via TaxprepConnect

e Importing slip data entered in Taxprep Forms or Taxprep for Trusts.

e Importing scanned data using the CCH Scan Auto-flow function.

e Exporting and importing data from one Personal Taxprep file to another.

e Importing data from a Planner file.

e Exporting data to create a Taxprep Forms file.

e Importing and/or exporting data between a Taxprep file and a generic file type
compatible with other applications.

TaxprepConnect

You can use the command TaxprepConnect Download on the File menu to download tax data
for the current year (e.g. T-slip data, Non-capital loss history, RRSP contributions and limits,
instalments) from the CRA as well as RL slips data (e.g. RL-1) from Revenu Québec (if
applicable). The tax data that can be downloaded from the CRA is the same data that is
viewable in My Account.

You may only download data for one client file at a time; however, you can download the
data for all of the returns within the client file at the same time for up to 10 family members.

To download tax data from the CRA, you must be the authorized representative for that
taxpayer and have online access to information through Represent a Client. TaxprepConnect
will launch the CRA's Tax information web service and you will need to login using your CRA
login and password or using partner credentials. Once logged in, the program will transfer
the SIN of the selected family members to the CRA and the data will then be downloaded
immediately.

To download tax data from Revenu Québec, you must either be the authorized representative
for the taxpayer or obtain a download code from Revenu Québec.
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Once the data has been downloaded, you can review it on the Form TaxprepConnect
Download (Jump Code: CONNECT) and then select the data that you wish to transfer to the tax
return.

Cells that have tax data transferred from the Connect form to the return will be identified
with a green background. If any of this data is changed after it has been transferred to the
return, the cell background will change to purple. A list of downloaded data transferred to
the return can also be viewed in Xpress using the filter Data transferred after TaxprepConnect
download.

Downloaded T3 data as well as downloaded T5008 data can be reconciled to the information
that the client received using the Forms TaxprepConnect - T3 Slips Reconciliation (Jump Code:
CONNECT T3 REC) and TaxprepConnect - T5008 Slips Reconciliation (Jump Code: CONNECT
T5008 REC) prior to transferring the downloaded data to the return.

Note that not all data will be available at the same time. It will vary depending on the type of
data and method of filing. For example, CPP and OAS information is normally available at the
beginning of tax season, while most T3 information will not be available until the end of
March. Also, any slips that were not filed electronically by the issuer will take significantly
longer to be available from the government download services.

You may, however, download data using TaxprepConnect multiple times. Taxprep will identify
slips that have been added or modified since the last download as well as identifying slips
that are no longer available for download.

You can also download tax data from the CRA for the previous nine tax years (2016, 2017, 2018,
2019, 2020, 2021, 2022, 2023 and 2024) and from RQ for the previous three tax years (2022, 2023
and 2024) using the appropriate version of Personal Taxprep. However, only T-slip data can
be downloaded for prior tax years. Other data, such as carry forward balances, can only be
downloaded for the current tax year.

For more information on using TaxprepConnect, refer to the Help.

Importing Taxprep T-slip data

If you are using Taxprep Forms or Taxprep for Trusts to prepare information slips, you can
automatically import certain T-slip data into Personal Taxprep.

The data entered in Taxprep Forms or Taxprep for Trusts for T3, T4, T4A, T5, or T5013 slips can
be exported to a common location that can be accessed by Personal Taxprep. The export is
done automatically whenever you print or transmit the T-slip.

Provided Personal Taxprep is configured to search in the same common location, when you
open a T1 return in Personal Taxprep, the program will search for any exported data for that
client (according to their SIN) and will prompt you to import it into your Personal Taxprep
datafile.

Alternatively, you can also manually import the data using the File/Import Data/Taxprep
Slips Data command in the Return view.

For more information on importing data from Taxprep Forms and Taxprep for Trusts, refer to
the Help.

Importing Scanned Data

CCH Scan can recognize and extract data from the most frequently used slips and RL slips.
Taxprep can then import this data directly in the corresponding forms and link every digitized
slip or RL slip to the form in which extracted data has been imported.

Importation can be done when opening the client file, at the same time that you select the
PDF documents to attach to the taxpayers’ returns. You can also link the slips or RL slips to
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the corresponding Taxprep forms and import the data at a later time using the command
Import data/CCH Scan data on the File menu.

For more information on importing data from CCH Scan, refer to the Help.

Importing from another Personal Taxprep File
There are two types of data that can be imported from one Personal Taxprep file to another:

e Self-employment and rental information

e Bankruptcy information

Importing Self-Employed and Rental Statements

The program allows you to import tax data from the return of a taxpayer who is a self-
employed individual or has a rental property into the return of his or her partner.

Only the data for the partnership will be imported. No expenses claimed by the partner
(rather than the partnership) will be imported.

Note: If the partner is the taxpayer’s spouse and the taxpayer and spouse returns are in the
same data file, then importing is not required. The spouse’s self-employment or rental
schedule can be created automatically by indicating that the spouse is a partner in the
relevant self-employment or rental statement.

For more information on importing data from self-employment and rental statements, refer
to the Help.

Import Bankruptcy Data

Personal Taxprep allows you to import pertinent tax data from a taxpayer’s pre-bankruptcy
return into the post-bankruptcy return.

The imported data is inserted in the appropriate forms as well as the Bankruptcy Information
form (Jump Code: BANKRUPTCY) of the active return.

Transferring Data between AgriStability/Agrilnvest and Form T2042

The program allows you to transfer data from Form T1163, AgriStability and Agrilnvest
Programs Information and Statement of Farming Activities for Individuals (Jump Code: 1163) to
Form T2042, Statement of Farming Income and Expenses (Jump Code: 2042), and vice versa, as
well as to Form T1273, Harmonized AgriStability and Agrilnvest Programs Information and
Statement of Farming Activities for Individuals (Jump Code: 1273), and vice versa. This is
necessary if a farmer either begins participation or withdraws from participation in the
AgriStability and Agrilnvest programs.

Refer to the Help for more information on transferring AgriStability and Agrilnvest data.

Importing Data from a Planner File

If Planner mode was used to create a Planner file in the prior year's version of Personal
Taxprep, the data from that Planner file can be imported into the current year file using the
command Import Data/Planner file data from the File menu.

For more information on Planner mode, refer to the Help.

Creating a Taxprep Forms File

You can use the command Create Taxprep Forms File on the File menu to create a Taxprep
Forms file and copy the appropriate data from Form Identification (Jump Code: ID) to the
Identification form of the new Taxprep Forms client file.
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This can be useful in situations where you need to prepare a form or information return that
is only available in Taxprep Forms (e.g., UHT 2900 - Underused Housing Tax Return and
Election Form).

You can also create a Taxprep Forms client file from the Client Manager.

Once the Taxprep Forms file has been created, Taxprep Forms will launch automatically so
that you can prepare the required forms or slips.

Importing and Exporting Other File Types

Personal Taxprep also allows you to import and export the following types of files:

e .csv files (separator: semicolon). This file format contains items from a spreadsheet or a
database with cells separated by semicolons and can be created with any type of text
editor;

e xls files (worksheet). This type of file is created with Microsoft Excel®.

Refer to the Help for more information on importing and exporting data.

Saving Returns

You must click the icon to save the data. If you attempt to close the return while there
is unsaved data, Personal Taxprep will prompt you to save the file prior to closing it.

Personal Taxprep will also automatically save periodic back-ups of your data files if they
contain any unsaved data. You can modify the interval at which the back-up files are saved in
Options and Settings.

All returns within the data file are saved automatically when the file is saved.
Notes to the File

Marc Roy and Carole Tremblay.125 - Properties X

When you save a file, by default Taxprep will

Genesal display the Properties dialog box. This
o T includes a section for notes that can be used
to record information about the return.
- |Marc Roy . . .
[ These notes can be edited and viewed in the
4 Information - . .
e e Client Manager. When rolling forward your
S 00300 43 files, you also have the option to roll forward
Return Status Rolled forward these r'IOteS.
4 EFILE Status
T Not eligible
TP1 Mot eligible
MR-69 Not applicable
T1135 Mot applicable
PAD Mot applicable W
Notes _f
--- Rolled forward, 2026-01-23 7:14:50 p.m. ---

Lock data

+| Show before saving Cancel
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Attaching External Files

You can attach any external file to your tax return file by clicking the @J icon on the
toolbar or the Attached Files command on the File menu. This dialog box is also accessible by
pressing Ctrl+F11.

You have the option of either saving a link to the selected file or embedding a copy of the
selected file within the Taxprep data file.

You can also use the Attached files command to attach a PDF of the signed MR-69
authorization request along with a supporting document, if applicable, to be electronically
transmitted to Revenu Québec. See page 32 for more information.

While almost any type of file can be attached, you cannot attach file types that are
executable and could therefore present a security risk (e.g. .exe, .bat, .chm, .js).

You can also automatically attach a PDF file generated using any of the print commands in
Personal Taxprep.

For more information on attaching external files, refer to the Help.

Reviewing Returns

Once you have entered all of the information into the tax return, you should review the
return to ensure accuracy. There are several ways of reviewing the return:

Xpress

Taxprep Xpress can also be used to review and verify data. It offers many filters that enable
you to, among other things, compare the values entered for this year with those from last
year. This way you can quickly notice errors or missing information. It also allows you to
review overridden and marked cells in the return by selecting the appropriate Xpress filter.

Track Changes

During the review process, you may wish to monitor any changes made to the return to
ensure that only the identified corrections are made and that no data is changed
inadvertently.

Activate the command Track Changes on the Edit menu and any changes made to the return
after that point will be tracked and can be viewed in Xpress using the filter “Data Modified
after activating Track Changes”.

Monitor

The monitor is a tracking tool that lets you display key tax information at the bottom of the
tax return window.

On the View menu, click Monitor to display or hide the monitor.

|Line 26000 - Taxable income : 74,500.00 ‘LHE4}5;C‘*TC{E‘;§E;B£} 5,588.25 ‘ Refund or balance owing : -411.75 Total payable (combined) : 5,588.25 |Ba\anci due or refund (combined) : -411.75 |

Certain values will be displayed in the Monitor by default: Federal Taxable Income, Total
Payable, Balance due/Refund, Total Payable (Taxpayer and Spouse), Balance due/Refund
(Taxpayer and Spouse). However, you can customize the Monitor’s contents by adding and
removing cells as well as adjusting their descriptions, width and display order.
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To add a cell to the Monitor, simply click the cell that you want to view and drag it onto the
Monitor.

You can also use the command Select Specific Return to specify that the value shown should
be from a specific return within the data file (e.g. the spouse’s return) rather than the active
return. When a monitor cell is associated with a specific return, it will have the same colour
background as the forms for that return.

When you customize the Monitor's contents, these settings are saved for your workstation
and will apply to all returns.

Diagnostics

You can display the list of diagnostics so that you can consult them as you work on the
return.

Ak
J O »

To view the list of diagnostics, click Diagnostics on the View menu, or click AS on the
toolbar.

You have two options for displaying the diagnostics: Dock and Float.

If you choose Dock, the list of diagnostics will be displayed in a pane at the bottom of the
Taxprep window.

If you choose Float, the diagnostics will be displayed in a separate window which you can
reposition (e.g. onto a second monitor).

You can also use the hotkey Alt+F5 to display the docked list of diagnostics and the hotkey
Alt+F6 to display the floating list of diagnostics. Alternatively, you can access the
Form Manager and enter the Jump Code DIAG to display the diagnostics.

Once the diagnostics are displayed, you can switch between display modes using the
icon on the Diagnostics toolbar.

To display diagnostics directly on a form, point to a cell with a diagnostic’s indicator and the
diagnostic message will be displayed. This information is available regardless of whether or
not the diagnostics pane is visible.

Diagnostics can be printed directly from the Diagnostics pane (either floating or docked)
using the command File/Print Diagnostics or they can be included in a print format so that
they are printed along with the return. By default, the diagnostics will be printed in the
“Office” copy of the return.

Customized Diagnostics

You can also create your own diagnostics in Taxprep in the view Filters and Diagnostics.
These diagnostics can be used to check for adherence with firm procedures (e.g. partner
name entered) or as a reminder for specific data entry requirements or tax issues.

In addition, for most items identified in our Troubleshooting memo, a customized client
filter/ diagnostic may be downloaded in order to assist in identifying returns affected by the
problem. These diagnostics will appear on the tab My Diagnostics along with any applicable
customized diagnostics you have created.

Refer to the Help for more information on how to create custom diagnostics.

Review Mode

When a return is being reviewed, the review mode allows you to add review marks to the
appropriate cells in the forms simply by clicking them.
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Review marks can be used to identify whether the data is correct or incomplete.

The following review marks are available:

Symbo Name of the
L review mark Recommended when...
. . The reviewer wants to indicate that the content of a cell has

v First review :
been reviewed once.

¥ Second The reviewer wants to indicate that the content of a cell has

review been reviewed a second time.

X Error The reviewer wants to let a preparer know that the content of
a cell contains an error.
The preparer wants to indicate that he or she is uncertain of

L) Uncertainty the content of a cell. This mark can also be used to represent
an estimate.
The preparer wants to indicate that the content of a cell must

i J || Other be reviewed for a reason other than the one previously

mentioned.

Notes: If you double-click a cell when the review mode is activated, a review mark is added
and then you can access the source form.

Review marks are not printed when you use the Print Return command. Review marks can be
printed using the Print Form command by using the print option Print as displayed.

Reviewing Diagnostics

You can mark diagnostics as “Reviewed” or “Ignored” by right-clicking the diagnostic in the
Diagnostics pane and selecting the desired annotation.

By default, all diagnostics will appear under the Take Action tab in the Diagnostics pane.
However, once a diagnostic is marked as “Reviewed” or “Ignored,” it will no longer appear
under the Take Action tab but will instead be shown in the Reviewed or Ignored tab, as

applicable.

This allows you to mark any diagnostics that cannot be cleared (e.g. a filing reminder), so that
upon subsequent review, you will know which diagnostics you have already reviewed.

Electronic Signatures

You can use an electronic signature on prescribed forms such as the T183 and TP 1000, TE-V
and T1135 forms.

If your client will be electronically signing Form T183, Information Return for Electronic Filing
of an Individual’s Income Tax and Benefit Return, answer Yes to the question Are you
planning on using an electronic signature method on Form T183? on the form and provide the
e-signature date and time in the fields indicated. This information will be transmitted with
the T1. Note that the answer to the e-signature question can be defaulted under the EFILE tab
in the Preparer Profile.

To streamline the e-signature process, built-in tags have been integrated into various forms
to indicate where the digital signature must be affixed. If you are using CCH iFirm Portal,
these tags allow you to streamline the publishing of forms that require your customer’s
digital signature. The CCH iFirm Portal integration will also automatically update the above-
mentioned e-signature date and time fields.

For more information, refer to the Help Centre for Personal Taxprep and/or the Help Centre
for CCH iFirm Portal.
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Printing

Printing Forms

Individual Forms
In the Tax Return view, you can print individual forms for any of the active returns.
On the File menu, click Print Form to print the current form that is on screen.

Note: When you use the Print Form command on a multiple copy form (e.g. a T-slip), only the
current copy will be printed. To print all copies of a multiple copy form, select the entry on
the Form Manager and then click Print Selected Form(s).

Multiple Forms

To print more than one form at the same time (but not necessarily the whole return):

1. Select the forms on the Form Manager.

2. On the File menu click Print Selected Forms.

3. Click OK to start printing.

Note: When viewing a form, the print command is called Print Form. When on the Forms
Manager, the print command is called Print Selected Forms.

Form Printing Options
You can select a number of options when printing individual forms:

e Mask the SIN in the form header and/or on the form itself
Print to PDF file

e Printa blank copy of the selected form(s).

e Print the form as displayed on screen.

e Override the date to be printed on the form(s).

e Page range to be printed (single form only).

e Print a watermark on the form(s).

e Use zoom printing to print more than one page per sheet of paper
e Select the language in which the form will be printed

You can also click the Options button to modify any of the print settings previously
configured under Options and Settings or to select PDF file options.

Printing Returns

You can print the returns included in the current client file by clicking Print Tax Return on the
File menu.

Viewing Diagnostics

When you use the Print Tax Return command, and there is at least one diagnostic that needs
to be corrected, the diagnostics will be displayed automatically prior to printing.

If applicable, click the arrow to view the diagnostics for the spouse or dependants.

Click Continue if you want to proceed with printing the return.
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Selecting Returns

Print Tax Returns X

Return selection

L Name language o o Details
& MarkBrown ‘English v [[v v A
Carol Brown .En.g.\.ii.h”” ¥
Janice Brown English 11O v
David Brown English
Kelly Brown English
Grandma Rrown Fnalich v
Print format selection
Name Copies PDF Watermark
v Clients 1 None L}
v| EFILE 1 None
Govt 1 None
Label - Etiquette 1 None
[ Office ® [ INene o

More printing options
Change status after printing: Printec
Pages per sheet: 1 v

Override date:

Options... Cancel Help

All of the returns in the current client file will be displayed. You can select which returns you
want to print.

Note: The selection of what will be printed for each copy of the return is saved in a template
file called a Print Format. For more information on customizing print formats, refer to the
Help.

All of the available print formats will be listed. You can change which print formats are
selected by clicking the adjacent check box.

All selected print formats will be produced for each return. (e.g. a client copy, an EFILE copy
and an office copy will be printed).

If you want to generate a PDF file instead of printing a hard copy, click the PDF box.
You can select a different watermark for each copy.

Click Options to change any of your configured print options prior to printing.

Printing Returns from Multiple Files

If you want to print returns from multiple data files, select the returns on the Client Manager
then click Print Tax Returns as you would for a single file.

PDF Printing

When generating PDF files, you can apply a password automatically to the generated PDF.
This helps ensure that the returns remain secure (e.g., when sending copies via Email). You
can also configure the file naming convention for the PDF files generated. These options can
be configured in advance using the command Options and Settings on the Tools menu, or
immediately prior to printing using the Options button in the Print Return dialog box.
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EFILE

Mandatory EFILE

Tax preparers who prepare personal tax returns for remuneration may be subject to a
penalty of $25 for failure to electronically file a T1 return. However, tax preparers may paper-
file up to 5 returns without penalty.

EFILE Security

Starting in February 2026, the CRA will implement a process that associates EFILE accounts
with specific certified T1 software products. This enhancement is designed to strengthen the
security of return submissions by ensuring that EFILE users submit their returns through the
specific software product(s) associated with their EFILE account.

For existing EFILE accounts, the CRA will automatically associate your EFILE account to your
preferred software product(s) based on your historical usage. However, if you have recently
switched from another T1 program to Personal Taxprep, please contact your EFILE helpdesk to
ensure that they have the correct software product registered. More than one software
product can be associated with your account (e.g. if your firm also files returns under the
same EFILE number using CCH iFirm Taxprep T1). New EFILE registrants will be contacted by
the EFILE helpdesk to confirm the software product(s) they will be using.

Beginning in February 2026, if a T1 return is submitted using a different software product than
the one(s) linked to your EFILE account, the return will be rejected, and the transmission will
fail.

Setup
To set up EFILE, proceed as follows:

1. Inthe Tools menu, click Options and Settings and complete the “Electronic Services”
section.

2. Inthe Preparer Profile, complete the EFILE tab.

Note: If you are electronically filing in a network environment, refer to the Help for additional
instructions on how multiple users can access the transmission information.

Electronically Filing Prior Year Returns

If you need to file a return for a tax year that precedes the current tax year, you will need to
use the appropriate version of Personal Taxprep for that tax year.

In order to transmit a return, you must have renewed your EFILE number for the current year
and have entered your current EFILE password in the “Electronic Services” section of
Tools/Options and Settings for the prior year Taxprep program.

Starting February 23, 2026, the CRA will accept electronic filing of the T1 return for the 2025,
2024, 2023, 2022, 2021, 2020, 2019 and 2018 tax years.

Selecting Returns

Before a return can be electronically transmitted, it must be selected for EFILE.

By default, the program will automatically select all returns for EFILE, but this option can be
modified in the EFILE tab of the Preparer Profile.
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You can change whether or not a specific return is selected for EFILE using the check box
Select this return for EFILE at the top of the Electronic Filing Worksheet (Jump Code: EFILE).

Similarly, to select an individual return for NetFile Québec, select the Select this return for
NetFile Québec check box at the top of the form Electronic Filing Worksheet - Québec (Jump
Code: QEFILE).

Authorizing Returns

The return must be authorized for EFILE on the T183 (TP-1000.TE-V for Québec) form in order
to EFILE. In the Preparer Profile, you can choose an option that automatically authorizes all
returns for EFILE.

If you have not automatically authorized all returns, then you can override this option at the
top of the T183 and TP-1000.TE-V forms.

Checking EFILE Eligibility

Once a return has been selected for EFILE and authorized, the program will determine if the
return is eligible for EFILE.

The program designates a return's EFILE status as "Eligible" when the return:
e has been selected for EFILE;

e meets the eligibility requirements; and

e has been authorized for EFILE.

To verify if a return meets EFILE eligibility requirements, display the diagnostics pane, then
click the EFILE tab to verify the EFILE diagnostics.

Note: The EFILE diagnostics are only generated after the return has been selected for EFILE.

Errors Detected

The EFILE diagnostics will indicate if there are any errors detected that could cause the
return to be rejected. These errors must be corrected in order for the return to be eligible for
EFILE.

Transmitting Returns

A return can be electronically transmitted from either the Tax Return view or the Client
Manager view. In the Tax Return view, you can only transmit the returns contained in the
active client file. In the Client Manager view, you can select returns from multiple client files
for electronic transmission.

Transmitting the Active Return
1. On the Transmission menu, click EFILE, and then click Transmit.

2. Click OK to transmit the return.

Transmitting Multiple Returns
1. Select the Client Manager view from the view list.

Click Current View, and then click EFILE Eligible.

2

3. Select the return(s) that you want to transmit.

4. On the Transmission menu, click EFILE, and then click Transmit.
5

In the Transmit dialog box, verify the returns that you want to transmit. You can remove
any returns from the list by removing the check mark beside the return. If a return is
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selected that is not EFILE Eligible, no check mark will appear beside that return and you
will be unable to select it for transmission.

6. Click OK to transmit the return.

Transmission Results

Once the returns have been transmitted, a dialog box will appear with the transmission
results. It will list the returns that have been transmitted and provide a confirmation number
for each accepted return or an error message for any rejected returns.

Use the Print button at the bottom of the dialog box to print the list for your records. You can
also view these results at any time by clicking EFILE Transmission Results on the
Transmission/EFILE menu.

The transmission results for each return are also recorded in Form EFILE Information (Jump
Code: EFILE INFO). If the tax authority accepts the return for processing, then the program will
automatically change the EFILE status to “Accepted.”

Re-transmitting Rejected Returns

If a return is rejected, this will be indicated in the EFILE Transmission Results dialog box
along with the error clue provided by the applicable tax authority and Taxprep will
automatically change the EFILE status of the return to “Rejected.”

The error message for a rejected return can be viewed on Form EFILE Information, (Jump
Code: EFILE INFO) within that return or using the EFILE Transmission Results command.

To avoid another rejection, ensure that you have corrected all the errors indicated by the tax
authorities prior to re-transmission. Taxprep will automatically change the EFILE status back
to “Eligible” when the return is recalculated.

Electronically Filing an Amended Return

If you discover a mistake and want to adjust the return after it has been assessed, you can
file a request for reassessment (also known as “filing an amended return”).

This request can be made in several ways:
e By electronically transmitting the revised T1 return (ReFILE)

e By requesting an adjustment online through the CRA’s Represent a Client service (if
you have level 2 authorization).

e Bysendingin arequest using Form T1-AD)

If you are preparing an adjustment request or wish to electronically transmit an amended T1
return for a prior tax year, you will need to use the appropriate version of Personal Taxprep.
ReFILE is available for the three prior tax years as well as the current year.

If you want to electronically transmit an amended T1 return, you will need to answer the
question below on Form T1-ADJ, T1 Adjustment Request (Jump Code: T1AD)).

ReFILE S

Do you want to electronically retransmit the amended T1 return (using the ReFILE service) instead of mailing a T1ADJ form? Yes E No l:‘

This question should be answered before making the adjustments.

Québec

Do you want to electronically retransmit the amended TP1 return instead of mailing a TP-1.R form? Yes E No E‘
Note: Revenu Québec requires a valid Form MR-69 for the electronic transmission of an amended TP1 return

The steps to follow differ depending on whether or not you are going to be using ReFILE.
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Regardless, once the option for calculating the automatic adjustment has been activated,
Personal Taxprep will automatically record the necessary adjustments on the T1-AD) for the
taxpayer as well as on the T1-AD) for the spouse, if applicable. In addition, both the original
and revised balance due/refund owing will appear at the bottom of the T1-AD).

If you are using ReFILE, the return can then be transmitted in the same manner as the original
return and a separate confirmation number will be issued.

Note that when electronically filing an amended T1 return, the entire T1 return is transmitted,
not just the T1-ADJ form. However, the T1-ADJ will still be automatically generated for
reference purposes.

Alternatively, you can submit a paper copy of the T1-ADJ to the CRA or use the information on
the T1-AD]J to assist in requesting the adjustment online through the Represent a Client
service.

For more information on electronically filing amended returns, refer to the Help.

Québec TP1 Returns

For adjustments to the Québec TP1 return, the Form TP1-R (Jump Code: QTP1R) can also be
automatically generated using the same method as the T1-AD).

Amended TP1 tax returns can be transmitted to Revenu Québec in a similar manner to
transmitting amended T1 returns.

To electronically transmit an amended TP1 return, answer “Yes” to the question Do you want
to electronically retransmit the amended TP1 return instead of mailing a TP-1.R form? This
question can be answered either at the top of the T1-AD) form or at the top of the TP-1.R
form.

Similar to preparing an amended T1 return, the program will use the Form TP-1.R, Request for
an Adjustment to an Income Tax Return (Jump Code: QTP1R) to track the adjustments being
made, however, the program will transmit an entire TP1 return reflecting the desired changes
and not just the TP-1.R.

However, unlike the CRA that requires that a new copy of Form T183 be signed before an
amended T1 return is transmitted, Revenu Québec does not require a signature on a new copy
of the TP-1000 form. However, they do require that the EFILER has a valid authorization or
power of attorney (Form MR-69) on file for the taxpayer.

The EFILE exclusions that apply to the transmission of the original TP1 returns also apply to
the transmission of amended returns.

If you are unable to electronically file the amended return, there are two options for
paper-filing an adjustment request:

1. Complete and print Form TP-1.R, Request for an Adjustment to an Income Tax Return
(Jump Code: QTP1R).

2. Make the changes to the return then reprint the entire return, including new bar
codes, using the “Govt” print format. In this case, you must attach Form TPF-1.C -
Explanations Regarding an Amended Income Tax Return (Jump Code: TPFIC) to your
amended TP1 return.

Multiple Amended Returns

Both the T1-ADJ and the TP1-R are multiple copy forms and can therefore accommodate
multiple adjustment requests.
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Electronically transmitting the T1135 Foreign Income Verification
Statement

If a taxpayer owns or holds foreign property at any time during the year with a total cost of
more than CAN $100,000, then the taxpayer is required to file a T1135, Foreign Income
Verification Statement (Jump Code: 1135).

The T1135 can be filed in paper format or electronically: there is currently no legislative
requirement to electronically file a T1135 information return.

The T1135 is separate transmission from the T1 return. However, in Personal Taxprep we have
implemented the electronic filing of the T1135 so that you can transmit both the T1(and TP1,
if applicable) and T1135 at the same time.

Alternatively, you can transmit the T1 without the T1135 or the T1135 without the T1.

Note that the Québec Form TP-1079.8.BE - Foreign Property Return, unlike the federal T1135
form, is not a separate transmission. The data entered on the TP-1079.8.BE form will be
transmitted as part of the TP-1 return. Therefore, it is important that this data be entered
prior to transmitting the TP-1 return.

T1135 EFILE Status

Similar to T1 EFILE, a T1135 must be selected for EFILE in order to be eligible for EFILE. In the
Preparer Profile, you can choose to have all of your T1135’s selected for EFILE automatically.

Provided all the required data has been completed, if the T1135 is selected for EFILE, then the
EFILE status of the form will become “Eligible”. This will be indicated in the Electronic Filing
section at the top of the form. The information on the transmission status of the T1135 is also
available using the File/Properties command (F11) and in the Client Manager.

Transmitting the T1135

The T1135 is transmitted using the same Transmit command that you use for transmitting T1
returns. (i.e., the command EFILE / Transmit on the Transmission menu)

If you have selected at least one client file that includes a T1135 with the EFILE status
“Eligible”, then the column for the T1135 will be displayed in the Transmit dialog box.

Transmit - Returns X
Client v T v g TP1 vl e T1135 v s PAD

i Mark Brown ~| Eligible ~  Eligible ~|  Eligible | Not applicable :
Carol Brown v|  Eligible 1 Noteligible 1 Not applicable v] Eligible

Janice Brown v| Eligible Not eligible Not applicable Mot applicable
David Brown Not applicable Not eligible Not applicable Not applicable
Kelly Brown Not applicable Nat eligible Not applicable Not applicable

Print Cancel Help

By default, all of the eligible T1135 forms will be selected for transmission.

Clear the box for the T1135 forms you do not want to transmit.
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If a selected return does not contain an eligible T1135, the T1135 check box will not be
selected and you will be unable to select the check box.

Similarly, if you wish to transmit a T1135 for a taxpayer for whom a T1 has already been filed,
you will be unable to select the T1 check box. For more information on electronically filing a
T1135, refer to the Help.

Pre-Authorized Debit Agreement

A Pre-Authorized Debit Agreement (PAD) is an electronic payment option that authorizes the
CRA to withdraw a pre-determined amount from the taxpayer’'s bank account to pay tax on a
specific date. To transmit a PAD agreement, you must first complete Form T185, Electronic
Filing of a Pre-authorized Debit Agreement (Jump Code: T185) and have your client sign the
agreement. Note that there is a delay of up to a five business-days in processing a PAD
agreement. Therefore, the withdrawal date entered must be at least 5 days later than the
current date.

The PAD agreement is transmitted separately from the T1 return. However, in Personal
Taxprep, the electronic filing of the PAD agreement has been implemented so you can
transmit the T1 return (as well as the TP1 return, if applicable) and the PAD agreement at the
same time. Alternatively, you can transmit a PAD agreement without the T1.

Transmission of a PAD agreement is only available for current year returns and is not
available for returns filed on behalf of deceased taxpayers.

Transmitting the PAD Agreement

The PAD is transmitted using the same Transmit command that you use for transmitting T1
returns. (i.e. the command EFILE/Transmit on the Transmission menu)

If you have selected at least one client file that includes a PAD agreement with the PAD EFILE
status “Eligible”, then the column for the PAD will be displayed in the Transmit dialog box.

For more information on the electronic transmission of a PAD agreement, consult the Help
with respect to the T185 form.

Electronic Filing of Authorization Requests

Federal Authorization

As of July 15, 2025, the CRA no longer accepts the transmission of authorization requests from
EFILE software for individuals (T1). In order to obtain authorization to access a client’s tax
data online (or to download the data via AFR), the individual must authorize the
representative through My Account, or the representative must submit an authorization
request via Represent a Client. For more information, refer to the CRA’s website:

https://www.canada.ca/en/services/taxes/resources-for-small-and-medium-
businesses/submitting-authorization-request.html

Québec Authorization

In order to transmit an MR-69 authorization request to Revenu Québec, you must have a
NetFile number and password and be registered as a professional preparer. Your
professional preparer number will be required on the MR-69 in order to electronically
transmit the form.

In addition, Revenu Québec requires that a PDF of all three pages of the signed Form MR-69
be transmitted along with every authorization request.
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Once the MR-69 form is completed in Personal Taxprep, it should be printed and signed by
the taxpayer. Then a PDF of the signed copy of the MR-69 should be attached to the return
using the Attached Files command (see page 22). The file name cannot exceed 60 characters
and cannot contain spaces or special characters (including accented letters).

In the Attached files properties dialog, select the check box for MR-69 in the Transmit with:
column on the left-hand side of the dialog. You will then need to select the type of
document. Select Signed Copy if you are attaching the PDF of the MR-69 that your client has
signed.

In addition, where the person signing the authorization is not the taxpayer (e.g., in the case of
a deceased taxpayer), Revenu Québec will require documentation to substantiate the
authority of the signatory to provide authorization. In that case, an additional document
should also be attached to the client file for transmission with the MR-69. Follow the same
procedures outlined above, selecting the appropriate type of document (e.g., “Other” to
provide a copy of the will or other document appointing the liquidator of the estate as well
as the proof of death).

As Revenu Québec will only accept a single supporting document in addition to the signed
MR-69, all supporting documents should be merged into a single PDF, JPEG or TIFF file.

Once all the required information has been provided, the document will be assigned an EFILE
status of Eligible. Only documents with an EFILE status of Eligible can be transmitted with the
MR-69.

Transmitting a Québec MR-69 Authorization Request

EFILE Status

The section Electronic Filing - Checklist at the top of the Québec MR-69 is used to determine
whether or not an authorization request will be eligible for EFILE.

All of the questions in the Checklist must be answered Yes in order for the authorization
request to be eligible for EFILE.

Note that as the client must sign the Authorization request prior to transmission, you must
print the MR-69 either to a printer or as a PDF in order for the authorization request to be
eligible for electronic filing.

In addition, an MR-69 request will only be eligible for electronic transmission once the signed
copy of the MR-69 has been attached to the return as described above.

The information on the transmission status of the authorization request is also available
using the File/Properties command (F11).

Transmission of one or more Authorization requests

The authorization request can be transmitted individually or in batch. You can use the Client
Manager to select multiple client files and transmit the Authorization request for the selected
files at the same time.

To transmit one or more Authorization requests, proceed as follows:

1. On the Transmission menu, click Authorization.

2. The Transmit dialog box displays. By default, all returns in the client file for which a
Québec authorization request is “Eligible” will be selected for transmission.

3. Clear the box for the authorizations requests you do not want to transmit.

4. If an authorization for one or more clients is not eligible for an authorization request
transmission, the applicable check box will not be selected and you will be unable to
select it for transmission of the authorization request.

5. Click OK to transmit the selected authorization requests.
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Rejected Authorization Requests

When you correct the information on a rejected Authorization request, if no other errors are
detected, the EFILE status will change to Eligible automatically when the return is
recalculated, similar to T1 EFILE

For more information on electronically filing an Authorization request, refer to the Help.

Help

The following Help resources are available in the program:

Tax and Form Help

Context-sensitive tax help is easily accessible from each cell by pressing F1 or by clicking
Personal Taxprep Help on the Help menu.

The Help Centre is online and requires Internet access. The Help Centre includes information
about using the program, completing the tax forms, electronic services, FAQ's,
Troubleshooting and Release Notes. It also includes links to many CRA and Revenu Québec
guides.

Knowledge Base

Our Knowledge Base contains an array of articles answering technical and tax questions most
frequently asked to our Support Centre agents. When you enter a few key words in the Search
field, articles will be displayed in order of relevance, providing you with valuable information
that will accurately answer your questions. You can use the filters on the left-side of the
screen to filter the results by product.

You can access the Knowledge Base from the Help Centre or directly from the
Professional Centre.

InfoConnect Tax Hints

Cells with a blue triangle in the bottom right corner have a direct link to a relevant section in
the electronic version of “Preparing Your Income Tax Returns” (Prep Book).

If you have a subscription to the electronic version of “Preparing Your Income Tax Returns”,
and you have this option enabled, then when you hover your pointer over the cell, an
InfoConnect tax hint will appear displaying the relevant tax hint. The tax hint consists of an
excerpt from this publication. You can then click the Learn More link at the bottom of the hint
to access the full topic in CCH AnswerConnect®.
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Il - Carrying charges, interest expenses, and other expenses
Select this box to indicate the percentage held by the taxpayer and the spouse D

Carrying charges (specify):

Advisor fees 0[00
0]00
0]00
Benefit resulting from a debt contracted for the acquisition of i : 0{00
Q
Select this box to indicate the percentage held by the taxpayer and the spouse I:J [1445] “Carrying Charges” Defined
Most reasonable expenses relating to the earnings of investment
Interest paid to earn investment income (specify): income are deductible. Such charges will include, for example,

interest on money b d to purchase in , fees for
the management of investments, and accounting and
bookkeeping fees for keeping records of investments.

Fees (other than commissions) paid to a professional investment
counsellor for managing or for advice on buying or selling
specific shares or securities of the taxpayer are deductible. A

Legal fees incurred to recover, establish or increase support payments

Carrying charges f'“" acquiring an interest in a partnership professional investment counsellor is ene whose principal

(limited or non-active partner): business is providing such management services or advice. Fees

Film property and commissions to stockbrokers are not per se deductible under

Rental and Ieasﬂg property this rule, but where ...

Flow-through shares and resource property Learn more Hide

Enter this amount on line 221 of your return. 221] Fﬁm
—— |

Interest expenses 9913 ﬂ

You can also view the InfoConnect tax hint by clicking the Prep Book button on the toolbar or
by pressing Shift+F1.

The display of InfoConnect can be enabled under Tools > Options and Settings > Options >
Tax Research.

The display of the InfoConnect tax hints can be disabled by clicking Hide at the bottom right
corner of the hint.

Technical Help

To get help on the operation of the program (as opposed to the tax forms), access the Help
Centre by clicking Personal Taxprep Help on the Help menu and then use the Search function
to find relevant help topics. You can also click the Help button in the various dialog boxes.

Virtual Agent

You can also obtain assistance using the advanced virtual agent.

Click the Virtual Agent button located in the top right corner of the program.

EH' MNone \/I

.Z_Hg Virtual -:xgentj

profile

Client profile

Client profile

The virtual agent provides:

o Direct descriptive answers to your queries based on our knowledge base articles,
allowing you to benefit from an efficient virtual conversation 24 hours a day, 7 days a
week.
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e The ability to chat with a live agent during business hours, so you can discuss your
question with a person in real time.

o The option to submit a support case.

Note that you must register for the Support Platform to access your requests and be able to
follow up on them.

Training

You can find information about current training opportunities by clicking Get Taxprep
Training on the Help menu.
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